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Chapter 1: Introduction
Welcome to xMatters (alarmpoint) for HP Network Node Manager i. This document describes how to install and

configure the xMatters (alarmpoint) for HP Network Node Manager i software integration. The intended audience for

this document is experienced consultants, system administrators and other technical readers.

1.0 Summary
xMatters is an interactive alerting application, designed to capture and enrich important events, to route those events

to the right person on any communication device, and to give that person the ability to solve, escalate, or enlist

others to resolve the events remotely.

xMatters allows you to take critical business information and contact the right people via voice phone, SMS, two-

way pagers, instant message, and email.

Through integration modules, xMatters can become the voice and interface of an automation engine or intelligent

application (the Management System, such as HP Network Node Manager i). When HP NNMi detects something

that requires attention, xMatters places phone calls, sends pages, messages, or emails to the appropriate personnel,

vendors or customers.

xMatters is also persistent, escalating through multiple devices and personnel until someone accepts responsibility or

resolves the problem. Once contacted, xMatters gives the notified person instant two-way communication with HP

Network Node Manager i. Responses are executed immediately on HP NNMi, enabling remote resolution of the

event.

This integration supports incident notifications (from HP NNMi to xMatters) through the use of web service calls

via the xMatters integration agent. It also supports inbound actions (from xMatters to HP NNMi) to acknowledge,

ignore, annotate and change incident priority remotely.

You will need to modify this configuration to suit your particular business requirements and adjust it to suit your

expected loads. For example, the default integration features automatic status annotations to the original event; in a

high-volume production system, this can significantly affect performance. Consider your expected volume of

injected events and your server capacity when designing your own integration with xMatters.

1.0.1 Benefits
With the xMatters integration, the appropriate technician can be notified directly via voice, email, pager,

BlackBerry, or other device. Information about the failure will be presented to the event resolver and decisions can

be made in real-time.

Once a response is selected on the recipient’s remote device, xMatters will update the HP NNMi incident in real-

time. The benefit is that this process is immediate – significantly faster than the time required for staff to notice the

failures or malfunctions, determine who is on call, and manually notify the right person. In addition, the ability to

take simple actions on the incident from any device gives the event resolver a quick way to deal with many issues

and communicate to other team members the current state of the event.

During the process, every notification, response, and action is logged in xMatters. In addition, xMatters

automatically annotates the original incident with status information.

The xMatters product features a self-service web user interface to allow accurate assignment of responsible personnel

for each job. xMatters also includes an optional enhanced Subscription panel that allows both managed and self-

subscription to HP NNMi events. This Subscription panel queries the HP NNMi Server directly in real time to

retrieve lists of important settings and criteria, removing the need to create and maintain these lists.
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1.0.2 xMatters mobile access
This version of xMatters also includes the xMatters mobile access application. With the mobile access component, the

appropriate technician can create, view, and update HP NNMi messages directly via a mobile device’s web browser.

Information about HP NNMi events can be displayed on the mobile device and updated in real-time.

The benefit is that this process is immediate and may be done remotely – providing users with an efficient method of

handling HP NNMi events from any mobile device. In addition, the HP NNMi integration can be updated to notify xMatters

Users on their mobile device with a link to the mobile view of the incident, allowing the user to update the incident

remotely.

1.0.3 Information Workflow
The following diagram provides an example of a standard workflow in a network monitoring system, and how information

from the management system can be passed into xMatters (alarmpoint) engine:

1.1.1 Integration Architecture
The software components in this integration include:

l xMatters (alarmpoint) engine and the mobile access component

l HP Network Node Manager i

l xMatters integration agent

The following diagram illustrates the software processes used by this integration:
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xMatters mobile access integration architecture
The following diagram illustrates the software processes used by the mobile access component of the integration:

The following steps occur for each action initiated by a mobile user (the steps correspond to the numbers in the above

diagram):
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1. A User sends a request from a mobile Device to xMatters mobile access.

2. The mobile access component processes the request and relays instructions to the xMatters integration agent.

3. The integration agent communicates with HP NNMi via the HP NNMi web services API.

4. The response is sent back to the integration agent via web services.

5. The integration agent processes the response and sends it to the mobile access component.

6. Rendered results are sent back to the mobile Device.

1.2 System Requirements
The following products must be installed and operating correctly prior to integration:

l xMatters (alarmpoint) engine 4.1 (patch 003 or later)with a valid xMatters mobile access license.

l xMatters integration agent 4.1 (patch 001 or later)

l xMatters Developer IDE

l HP Network Node Manager i 9.10

1.2.1 Operating Systems
The following operating systems are supported by this integration:

l Microsoft Windows 2003 (validated)

l Microsoft Windows 2008 (validated)

l Sun Solaris 9

l HP-UX B.11.23

l AIX 5.3

l Linux Redhat AS/ES 5.2

1.3 Conventions and Terminology
This section describes how styles are used in the document, and provides a list of definitions.

1.3.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu,

and then click the Open menu option.

Words in bold typically reference text that appears on the screen. Words in monospace font represent the following:

l text that must be typed into the computer

l directory and file names

l code samples

Directory paths
Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must substitute

the given paths with the Unix equivalents.

The xMatters installation folder is referred to throughout the documentation as <xMHOME>.

l On Windows systems, the default is C:\Program Files\AlarmPointSystems\AlarmPoint\

l On Unix systems, the default is /opt/alarmpointsystems/alarmpoint/
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The xMatters integration agent installation folder is referred to throughout the documentation as <IAHOME>.

l On Windows systems, the default is C:\Program Files\AlarmPointSystems\IntegrationAgent\

l On Unix systems, the default is /opt/alarmpointsystems/integrationagent

1.3.2 Terminology
The following terms are used through the xMatters documentation.

Term Meaning

Event An event refers to any situation or item of interest detected by the management system, and which

requires attention. Event is also used to refer to the incident or situation as it progresses through the

xMatters system, from injection to notification to resolution. Each event must generate at least one

alert or notification.

Event can also be a generic term used to refer to an incident, change request, message, or other

specific item within the management system. Whenever possible, these situations are referred to

using the management system's preferred terminology, but can also collectively be called events.

Management system A management system is any sort of monitoring or managing software that watches for events, and

with which xMatters can combine; i.e., a synonym for HP NNMi.

Device The medium through which a recipient is contacted by xMatters; i.e., email, pager, phone,

BlackBerry, etc.

User In xMatters, people who can receive notifications are called "Users". Each person in the xMatters

system is defined by a set of User details, including ID number, user name, login password, and so

on.

Group Groups are used to collect and organize Users and Devices into notification schedules. For a

complete explanation of Groups in xMatters, see the xMatters (alarmpoint) engine user guide.

Documentation terminology
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Chapter 2: Installation and Configuration
This chapter provides information about installing the xMatters (alarmpoint) for HP Network Node Manager i integration.

This chapter also contains complete instructions on how to configure xMatters, HP NNMi, and the integration components.

2.1 Installing the integration
The instructions in this chapter do not include information on how to install xMatters (alarmpoint) engine, the xMatters

integration agent, or HP Network Node Manager i. These components must be installed according to their related

documentation, and operating properly before you can proceed with the integration.

Note: For more information about installing xMatters (alarmpoint) engine and other xMatters products, refer to the

xMatters web site at http:///www.xmatters.com.

2.1.1 Integration components
The following table describes some of the notable components in the integration archive file:

Component Name Description

hpnnmi.js Script containing logic on who to notify in xMatters, and the content of the

notifications.

nnmi-config.js Contains configuration settings for the WS Eventing subscription service.

alarmpoint-nnmi.jar Contains the Web Services Library, which is used in the Action Scripts to inject

responses back to HP NNMi, and used by the Subscription Panel to retrieve the

available Source Node Names

NNMiSubscriptionForm.jsp Custom Subscription JSP that allows users to subscribe to Events associated with

specific criteria (CATEGORY, SEVERITY, etc.).

xM-HP-NNMi.aps Contains the xMatters Action Scripts required for the integration.

Integration components

2.1.2 Installing the integration service
To enable the HP NNMi integration service, you must copy the folder containing the integration agentfiles into the xMatters

integration services folder and modify the hpnnmi.js and IAConfig.xml files. If you have more than one integration agent

providing the "hpnnmi" service, repeat the following steps for each one.

To install the integration service:

1. Copy the xM-HP-NNMi\components\alarmpoint-integration-agent\hpnnmi folder from the extracted integration

archive to the <IAHOME>\integrationservices folder:

2. Open the IAConfig.xml file found in <IAHOME>\conf and add the following line to the “service-configs” section:

<path>hpnnmi/hpnnmi.xml</path>

3. Open the <IAHOME>\integrationservices\hpnnmi\nnmi-config.js file and modify the following variables:
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Setting Default Value Description

NNMI_HOST localhost To configure this setting, replace

"localhost" with the IP address of your

local server on which the WS-Eventing

subscription service is installed.

NNMI_PORT 80 To configure this setting, replace "80"

with the port number of your local server

on which the WS-Eventing subscription

service is installed. (For instructions on

how to determine the port required, see

"Identifying your HP NNMi port" on

page 31.)

NNMI_USER webservices Specifies the username of the web

services client account to use when

connecting to the HP NNMi web

services.

For more information, see "Creating a

web services client" on page 30.

NNMI_PASSWORD nnm Specifies the password for the web

services account.

FILTER nature='ROOTCAUSE' and

lifecycleState='com.hp.nms.incident.lifecycle.Registered'

and severity='CRITICAL' and (

name='AddressNotResponding' or

name='ConnectionDown' or name='InterfaceDown' or

name='NodeDown' )

Specifies the filter to use when

determining whether an event should be

forwarded to xMatters.

For instructions on how to update this

setting, refer to "Updating the event

injection filter" on page 18.

SERVICE_URL http://localhost:8081/http/hpnnmi_hpnnmi Specifies the call back to the integration

agent when subscribing to the WS-

Eventing service.

Requires the following format:

http://{service-gateway-host}:{service-

gateway-port}/http/{domain}_{name}

4. Restart the integration agent.

l On Windows, the integration agent runs as a Windows Service; on Unix, it runs as a Unix daemon.

2.1.3 Installing the integration libraries
To enable web service calls between the xMatters and HP NNMi servers, you must copy the JAR file into the xMatters Node,

and the xMatters web server library folder.

To install the integration libraries:

1. Copy the xM-HP-NNMi\components\alarmpoint\WEB-INF\lib\alarmpoint-nnmi.jar file from the extracted

integration archive into the <xMHOME>\node\lib\node-lib\ folder.
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Note: If you have installed more than one web server; install the JAR files into the web server library (node-lib) folder

on each one.

2.1.4 Installing the mobile access component files
To enable the mobile access component, you must copy the folder containing the JSP files into the xMatters mobile access

folder. If you have more than one web server, copy the JSP files into the indicated folder on each web server.

To install the mobile access component files:

1. Copy the xM-HP-NNMi\components\alarmpoint\mobilegateway\ folder from the extracted integration archive to

the <xMHOME>\webserver\webapps\mobilegateway folder on the xMatters server.

l Note that this change will overwrite several files and directories on the xMatters server; if you have made any

changes to these files, ensure that you create backups before overwriting your existing files.

2.1.5 Installing the subscription files
To use the optional subscription panel, you must copy the folder containing the JSP files, tag libraries, and new JAR files

into the xMatters installation folder. If you have more than one web server, repeat the following steps for each one.

To install the JSP files:

1. Copy the xM-HP-NNMi\components\alarmpoint\WEB-INF\ folder from the extracted integration archive into the

<xMHOME>\webserver\webapps\cocoon\.folder on the xMatters web server.

l Note that this change will overwrite several files and directories on the xMatters server; if you have made any

changes to these files, ensure that you create backups before overwriting your existing files.

2. Open the <xMHOME>\webserver\webapps\cocoon\WEB-INF\web.xml file, and add the following lines before the

</web-app> tag

<taglib>

<taglib-uri>http://alarmpoint.com/alarmpoint/4.0#integrationservices</taglib-uri>

<taglib-location>/WEB-INF/classes/resources/tld/apia.tld</taglib-location>

</taglib>

3. Restart the web server.

2.1.6 Installing voice files
These files must be installed into any xMatters deployment running a voice Device Engine. For more information, refer to the

xMatters (alarmpoint) engine installation and administration guide.

To install the voice files:

1. Copy all of the files in the xM-HP-NNMi\components\alarmpoint\vox\english folder from the extracted integration

archive to the following node installs folder:

<xMHOME>\node\phone-engine\Datastore\domains\common\recordings\english\phrases

Note: This integration provides a complete set of English voice files.

2.2 Configuring xMatters
The following sections explain how to configure the xMatters components and settings to combine with HP NNMi.
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2.2.1 Importing the script package
This integration includes a set of customized Action Scripts specific to HP NNMi that must be imported into the xMatters

scripts. The default callout scripts in a standard xMatters deployment are not configured to use web services to annotate the

originating incident, and must be updated to inject messages back to the HP NNMi integration action scripts.

Note: This step requires the xMatters Developer IDE. For installation instructions and more information about scripting

in xMatters, refer to the xMatters Online Developer's Guide.

To import the xMatters Script Package:

1. Launch the xMatters Developer IDE, and then configure the database connection.

2. Click Workspace > Import.

3. Select the xM-HP-NNMi\components\alarmpoint\scripts\xM-HP-NNMi.aps file extracted from the integration zip

file, and then click OK.

4. When the script has finished importing, click OK.

5. Click Database > Check Out.

6. In the Check Out dialog box, click Check Out.

7. In the Workspace pane, expand the Default Company > callout (CALLOUT) > PRODUCTION > CONTACT

folders, and then double-click the callout script.

8. At the top of the callout script, insert the following line:

import com.invoqsystems.apex.component.broker.process.scriptObjects.ScriptObjectLinkedHashMap

9. In the callout script, locate the following line:

@initiatingEvent = @interaction::getInitiatingEvent()

10. Immediately after the getInitiatingEvent line, add the following:

GOSUB configureAdditionalESMTokens

11. Scroll to the bottom of the window, and add the following code to the end of the script:

# Add any additional tokens required for the callout annotate here

configureAdditionalESMTokens:

@esmTokens = new ScriptObjectLinkedHashMap()

@script::log("Agent Client ID: " & $initiatingEvent.agent_client_id)

IF ($initiatingEvent.agent_client_id == "hpnnmi|hpnnmi")

@esmTokens::put( "nnmid" , $initiatingEvent.nnmid )

ENDIF

RETURN

12. Locate each ::send() call in the callout script (there should be eight instances), and add the following code

immediately BEFORE each one:

$<varName>.additionalTokens = @esmTokens::getSerializedEntrySet()

Note: Replace <var_name> with the name of the ExternalServiceRequest object included in the send call. For an

example, see below.

13. Right-click the CONTACT:callout script and select Save.

14. Open the INTERACTION:authenticate script, and repeat step 12.

l Note that there are two instances of the ::send() call in the authenticate script.

15. Right-click the INTERACTION:authenticate script and select Save.

16. Click File > Save All.

17. Right-click the Default Company folder, and then select Validate.
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18. Right-click the Default Company folder, and then select Check In.

19. In the Create Script Package dialog box, click Create., and then click Close.

Example:
The following is an example of an enhanced segment of code:

Before:

if ($sessionTimeout)

$reportedFailure = @session::reportFailure($notId, "SESSION_TIMEOUT")

@sessionTimeoutMessage = @initiatingEvent::createExternalServiceMessage()

$sessionTimeoutMessage.message = "Callout to " & $targetName & " ended due to exceeding the max

session timeout (SESSION_TIMEOUT)."

@sessionTimeoutMessage::send()

endif

After:

if ($sessionTimeout)

$reportedFailure = @session::reportFailure($notId, "SESSION_TIMEOUT")

@sessionTimeoutMessage = @initiatingEvent::createExternalServiceMessage()

$sessionTimeoutMessage.message = "Callout to " & $targetName & " ended due to exceeding the max

session timeout (SESSION_TIMEOUT)."

$sessionTimeoutMessage.additionalTokens = @esmTokens::getSerializedEntrySet()

@sessionTimeoutMessage::send()

endif

2.2.2 Configuring the Event Domain
By default this integration is set up to use an Event Domain of “hpnnmi”; it is strongly recommended that you use this

default Event Domain.

The xMatters (alarmpoint) engine web server must be running to perform this portion of the integration.

To define an Event Domain:

1. Sign on to xMatters as a Company Administrator, and click the Developer tab.

2. In the Developer menu on the left side of the screen, click Event Domains.

3. On the Event Domains page, click Add New.

4. Enter the following information into the form:

l Name: hpnnmi

l Description: HP NNMi Integration

l Script Package: HP Network Node Manager

5. Click Save.

Defining an Integration Service
The mobile access component for this integration uses a default integration service of “hpnnmi”; it is strongly recommended

that you use this default integration service. For the installation to be successful, the integration service name must match the

name specified in the hpnnmi.js file and the IAConfig.xml file installed on the integration agent.

To define an Integration Service:

1. In xMatters, on the Event Domains page, click the hpnnmi Event Domain.

2. On the Event Domain Details page, in the Integration Services area, click Add New.
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3. Enter the following information into the form:

l Name: hpnnmi

l Description: HP NNMi Integration Service

l Path: hpnnmi/menu.jsp

4. Click Save.

Defining Event Domain Constants
Company Administrators and Developers can create Event Domain Constants that will be available in scripting for all event

objects associated with an Event Domain.This integration uses Event Domain Constants to define custom values for the

integration script package.

The integration script package uses the names of the constants defined in the table below to look up the values; it is strongly

recommended that you use the names specified, or speak to an xMatters client assistance representative before changing these

values.

Note: The values for the alarmpointurl and bespushurl constants should be modified to specify the address of the xMatters

web server (to enable the HMTL response options) and the BES device server.

To add an Event Domain Constant:

1. In xMatters, click the Developer tab, and then, in the menu on the left side of the screen, click Event Domain

Constants.

2. In the Event Domain drop-down list, select hpnnmi.

3. On the Event Domain Constants page, click Add New.

4. Define a Constant Name, Value, and Description for the new constant, according to the table below.

5. Click Save.

6. Repeat the above steps for each of the constants you want to add.

l Note that if the constants are not defined in the web user interface, the scripts will use the values listed in the

Default Values column of the following table.

Note: Shaded rows indicate mandatory settings that are specific to your deployment. You must change the default settings

to match your instance.
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Constant Name Default Value Description

xmattersurl http://localhost:8888 Used to specify the address of

the xMatters web server. The

links provided in notification

content use the alarmpointurl

constant value to locate the

xMatters web server which

would process the response.

For these links to work, this

address must be reachable

from the Device where the

User will receive the

notification; normally, this is

the IP address or fully-

qualified host name of the

xMatters web server.

Populates the

$main.alarmpoint_url

variable.

bespushurl http://localhost:8888/static Used to specify the address of

the BES device server.

Populates the $main.bes_

pushurl parameter.

forcefyi disable Force notifications to be

informational only (FYI),

rather than requiring

responses; this overrides the

fyi behaviour specified on the

injected event. Possible

values:

l disable: Nothing is

forced.

l on: Notifications are

forced to be FYI.

l off: Notifications are

forced not to be FYI.

Populates the force_fyi

parameter.

Event Domain Constants
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Constant Name Default Value Description

failsafegroup HP NNMi Fail Safe The fail-safe recipient to

notify, typically a group.

The fail-safe group identifies

the recipient that will be

notified if an event is injected

to xMatters (alarmpoint)

engine and no subscriptions

exist that match the event. Set

this constant if you want to

change the failsafe group from

HP NNMi Fail Safe to

another group defined in

xMatters.

failsafe enabled Controls fail-safe

functionality, notifying the

fail-safe recipient via EMAIL

under certain circumstances;

possible values are:

l enabled: Notify if no

subscriptions match or

no notifiable recipients.

l for-subscriptions:

Notify if subscription

functionality is enabled

AND no subscriptions

match.

l for-recipients: Notify if

no notifiable recipients.

l disabled: Disable fail-

safe functionality.

Populates the $fail_safe

parameter.

overridetimeframes false Override Recipients Device

Timeframes.

Populates the $override_

timeframes parameter.

useemergencydevices false Force the use of emergency

Devices.

Populates the $use_

emergency_devices

parameter.
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Constant Name Default Value Description

trackdelivery true Track when each device is

delivered to. Setting this to

false may give a performance

advantage, but you lose any

information about whether a

delivery was successful or

not.

Populates the $track_

delivery parameter.

annotate true Enables submission of

annotations back to the

management system.

Populates the

$main.annotate parameter.

subscriptionannotate true Enables submission of

Subscription annotations back

to the management system.

Populates the

$main.subscription_

annotate parameter.

tracksubscriptiondelivery true Track when each device is

delivered to for Subscriptions.

Populates the $track_

subscriptionDelivery

parameter.

timeout 259200 Amount of time (in seconds)

the event is allowed to run

before timing out. 259200

seconds = 72 hours.

Populates the

$main.timeout parameter.

maxinvalidresponses 3 Specifies the maximum

number of invalid responses

allowed before notification is

no longer requeued.

Populates the

$

main.maxInvalidResponses

parameter.
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Constant Name Default Value Description

enablehtmlemail true Enables HTML email

functionality.

Populates the

$main.enable_HTML_Email

parameter.

uselogo true Set this if you want the logo

displayed within HTML

email notifications.

Populates the $main.use_

logo parameter.

useurlalias false Indicates how Response

Choices are presented to

xMatters to ensure that the

user is authenticated in the

correct company so the

notification can be updated.;

set to true for xMatters on

demand integrations.

debug false Indicates whether to use the

debug level for logging

messages.

Populates the $main.debug

variable.

enablesubscriptions true Indicates whether to enable

processing of Subscriptions

on incoming events.

subscriptionfyi false Indicates whether

Subscriptions should be

forced to be informational

only (FYI).

numericpagernumber 555-1212 The callback number to be

used as the subject for

outgoing notifications to

numeric pagers.

NNMiowner xMatters Specifies the default

Windows Domain User to be

used for ownership of HP

NNMi alerts

NNMiownercustomfield HP NNMi Login Specifies the name of the

custom field that will contain

the HP NNMi owner;

overrides NMMi owner field.
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Constant Name Default Value Description

NNMipasswordcustomfield HP NNMi Password Specifies the name of the

Custom Field that will

contain the HP NNMi user

password.

NNMiwebserviceusername webservices Specifies the user name to use

for the HP NNMi web

services client user.

NNMiwebservicepassword nnm Specifies the password to use

for the HP NNMi web

service.

NNMiincidenturl http://localhost:80/IncidentBeanService/IncidentBean Specifies the url for the HP

NNMi web service.

usemobileaccess true Indicates whether to use the

mobile access component.

mobileaccessintegrationservicename hpnnmi Integration service name

available in xMatters mobile

access.

2.2.3 Defining Custom Fields
This integration uses custom fields defined in xMatters to obtain authentication credentials for submitting notification

responses and annotations to HP NNMi. These custom fields enable the response option list to be displayed on notifications.

The mobile access component uses custom fields defined in xMatters to obtain authentication credential for logging into HP

NNMi. These custom fields are optional for the mobile access component as a login page will be displayed if the custom

fields are not provided.

By default, the custom fields are “HP NNMi Login” and “HP NNMi Password”; it is strongly recommended that you use

these default field names.

To define the custom fields:

1. In xMatters, click the Admin tab, and then, in the Administration menu on the left side of the screen, click Custom

Fields.

2. Click Add New, and then enter the following information into the form:

l Field Name: HP NNMi Login

l Type: Text

3. Click Save.

4. Click Add New, and then enter the following information into the form:

l Field Name: HP NNMi Password

l Type: Password

5. Click Save.

Note: For more information about custom fields, see the xMatters (alarmpoint) engine installation and administration

guide.
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2.2.4 Configuring Users
Each xMatters User that will be notified and respond to notifications must be configured to allow xMatters to communicate

with HP NNMi as that User. Note that each User must also be configured in HP NNMi.

To configure a User for mobile access to HP NNMi:

1. In xMatters, click the Users tab.

2. Use the Find Users page to locate the User you want to configure and view their details.

3. On the Details for User page, select the Has Mobile Access check box.

l If you defined the custom fields, enter their HP NNMi login credentials in the HP NNMi Login and HP NNMi

Password custom fields.

4. In the Common Tasks pane, click User Devices.

5. Verify that an appropriate Device exists and that it is enabled.

6. Click Save.

Note: If you have no Users in the system, you can use the default demonstration User, "bsmith". If this User does not exist,

create a User with the User ID “bsmith”, and add a virtual text phone Device. Ensure that the User also has access

to the mobile access component. For more information and instructions on how to perform these tasks, refer to the

xMatters (alarmpoint) engine user guide.

2.2.5 Updating event recipients
To select a target for an incident you must update the integration agent service javascript file, hpnnmi.js, used to create the

xMatters event information. By default, the recipients are set to “operations”. The contents of the file resemble the following:

/**

* This is the injection point to xMatters from NNMi Subscription

*

* This method will parse the NNMi callback request and generate an APXML Message to be

* sent to xMatters via the ServiceAPI.

*

* Modify the apxml object to add tokens injected to xMatters.

* NNMi incident information can be retrieved from the E4X XML object 'content'

*

* For example use the following command to retrieve the uuid:

* content.uuid.text();

*/

function apia_http( httpRequestProperties )

{

...

// determine recipient via name of incident

if ("AddressNotResponding".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else if ("ConnectionDown".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else if ("InterfaceDown".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else if ("NodeDown".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else

{
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data.appendChild(<recipients>Operations</recipients>);

}

...

}

The following steps illustrate how to add the “NonSNMPNodeUnresponsive” event type and specify its recipient as “nnmi_

group1”, and how to specify a default recipient of “bsmith” for any undefined event types:

1. Open the <IAHOME>\integrationservices\hpnnmi\hpnnmi.js file.

2. Locate the section that begins with the following comment:

// determine recipient via name of incident

3. Add the following code:

else if ("NonSNMPNodeUnresponsive")

{

data.appendChild(<recipients>nnmi_group1</recipients>);

}

4. Save and close the hpnnmi.js file, and restart the integration agent.

The added code looks at the name of the incident, and if it matches, sets nnmi_group1 as the recipients token in the APXML

submitted to xMatters. The resulting section should resemble the following:

// determine recipient via name of incident

if ("AddressNotResponding".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else if ("ConnectionDown".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else if ("InterfaceDown".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else if ("NodeDown".equals(incidentName))

{

data.appendChild(<recipients>Operations</recipients>);

}

else if ("NonSNMPNodeUnresponsive")

{

data.appendChild(<recipients>nnmi_group1</recipients>);

}

else

{

data.appendChild(<recipients>Operations</recipients>);

}

2.2.6 Updating the event injection filter
By default, this integration is configured to receive all events in HP NNMi where:

l the nature of the event is ROOTCAUSE;

l the lifecycleState is com.hp.nms.incident.lifecycle.Registered;

l the severity is CRITICAL;

l and, the Event Type is one of AddressNotResponding, ConnectionDown, InterfaceDown,

NonSNMPNodeUnresponsive, or NodeDown.

This is specified in the default filter in the <IAHOME>\integrationservices\hpnnmi\nnmi-config.js file as follows:

// Filtering for subscription.

// Only matching Incidents will trigger the subscription call back
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var FILTER = "/sys:onNotification/arg0[nature='ROOTCAUSE' and

lifecycleState='com.hp.nms.incident.lifecycle.Registered' and severity='CRITICAL' and (

name='AddressNotResponding' or name='ConnectionDown' or name='InterfaceDown' or name='NodeDown'

or name='NonSNMPNodeUnresponsive')]";

The following NNMi incident parameters can be used in this filter expression:

Data Type Filter Name NNMi Web Field Possible Values

Int id

String uuid

String sourceUuid

String sourceName Source Object

String sourceNodeUuid

String sourceNodeName Node Name

String name Name

String severity Severity NORMAL

WARNING

MINOR

MAJOR

CRITICAL

String priority Priority com.hp.nms.incident.priority.Low

com.hp.nms.incident.priority.Medium

com.hp.nms.incident.priority.High

com.hp.nms.incident.priority.Top

com.hp.nms.incident.priority.None

String lifecycleState Lifecycle State com.hp.nms.incident.lifecycle.Registered

com.hp.nms.incident.lifecycle.InProgress

com.hp.nms.incident.lifecycle.Completed

com.hp.nms.incident.lifecycle.Closed

String category Category com.hp.nms.incident.category.Fault

com.hp.nms.incident.category.Status

com.hp.nms.incident.category.Config

com.hp.nms.incident.category.Accounting

com.hp.nms.incident.category.Performance

com.hp.nms.incident.category.Security

com.hp.nms.incident.category.Alert



xMatters (alarmpoint) for HP Network Node Manager i

Chapter 2: Installation and Configuration | 20

Data Type Filter Name NNMi Web Field Possible Values

String family Family com.hp.nms.incident.family.Address

com.hp.nms.incident.family.Interface

com.hp.nms.incident.family.Node

com.hp.nms.incident.family.OSPF

com.hp.nms.incident.family.HSRP

com.hp.nms.incident.family.AggregatePort

com.hp.nms.incident.family.Board

com.hp.nms.incident.family.Connection

com.hp.nms.incident.family.Correlation

String origin Origin MANAGEMENTSOFTWARE

MANUALLYCREATED

REMOTELYGENERATED

SNMPTRAP

SYSLOG

OTHER

String nature Correlation Nature ROOTCAUSE

SECONDARYROOTCAUSE

SYMPTOM

SERVICEIMPACT

STREAMCORRELATION

NONE

Int duplicateCount Duplicate Count

String formattedMessage Message

Boolean rcaActive RCA Active

Date originOccurrenceTime Origin Occurrence Time

Date firstOccurrenceTime First Occurrence Time

Date lastOccurrenceTime Last Occurrence Time

Date created Created

Date updateTime

String previousLifecycleState

String previousRcaActive

Note: For more details, refer to the HP Network Node Manager i Software Developer’s Toolkit.
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For example, to change the filter so only incidents with a priority of “Top” or “High” should be injected into xMatters, you

would change the filter to resemble the following:

var FILTER = "/sys:onNotification/arg0[priority='com.hp.name.incident.priority.High' or

priority='com.hp.nms.incident.priority.Top']";

To customize the injection filter:

1. Open the <IAHOME>\integrationservices\hpnnmi\nnmi-config.js file.

2. Locate the FILTER variable, and update it to match your requirements.

3. Save and close the file, and then restart the xMatters web server.

2.2.7 Configuring the web services connection
This integration uses the following default settings to connect to HP NNMi via web services:

NNMi Web Services NodeBean

Defined in the xMatters initial PROCESS script (and the Event Domain Constants described in "Configuring the Event

Domain" on page 10) as:

http://localhost:80/IncidentBeanService/IncidentBean

Defined in the xMatters Subscription Panel as:

http://localhost:80/NodeBeanService/NodeBean

The following settings are defined in the nnmi-config.js file, as described in "Installing the integration service" on page 6.

NNMi Web Services WS-Eventing (Subscription Manager):

http://localhost:80/nms-sdk-notify/

NNMi Web Services Client User:

webservices

NNMi Web Services Client Password:

nnm

Configuring xMatters for a different HP NNMi port
If your HP NNMi deployment is running on a port other than 80 (or if you require a different URL or User/Password

combination), you must change the settings in the custom Subscription panel and in the initial PROCESS script.

Note that you must also update the "NNMI_URL" parameter in the nnmi-config.js file to reference the correct port, as

described in "Installing the integration service" on page 6.

To change the NNMi web services connection configuration in the initial PROCESS script:

1. Launch the xMatters Developer IDE.

2. Check out the HP Network Node Manager (Business) script package.

3. In the initial PROCESS script, locate the following line:

$main.nnmi_incident_url = "http://localhost:80/IncidentBeanService/IncidentBean"

4. Edit the HP NNMi server name and port settings to the correct values and save your changes.

5. Check in the script package and close the xMatters Developer IDE.
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Note: For instructions on how to configure the Subscription panel’s Web Services connection, see "Configuring the

Subscription JSP" on page 26.

2.2.8 Initializing the web services library
This integration uses web services to post responses to HP NNMi and to populate the Subscriptions Source Node Name list.

The xMatters web server automatically picks up the installed library if it is installed to the correct folder (for instructions, see

"Installing the integration libraries" on page 7).

To enable Web Services for the xMatters node, you must modify the node configuration script so responses may be posted to

the HP NNMi server.

To configure the node to initialize the web service library on Windows:

1. Open the <xMHOME>\common\node-start.conf file.

2. Find the following classpath configuration section:

# Class path info

-classpath

3. Add the following to the end of the classpath within the quotations:

;C:\Program Files (x86)\AlarmPointSystems\AlarmPoint\node\lib\node-lib\alarmpoint-nnmi.jar

4. Restart the xMatters Node Service.

To configure the node to initialize the web service library on Unix:

1. Open the <xMHOME>/node.sh script.

2. Find the declaration of the CLASSPATH variable.

3. Add the following to the end of the classpath, within the quotations:

:/opt/alarmpointsystems/alarmpoint/node/lib/node-lib/alarmpoint-nnmi.jar

4. Restart the xMatters Node Daemon.

Your notification responses will now be posted to the HP NNMi server using web services.

For xMatters responses to update the incident using web services, the nnmi_incident_url (located in the initial PROCESS

Action script) must be a valid URL for the NNMi server’s IncidentBean; for more information, see “Global Configuration

Variables” on page 40.

2.3 Configuring the Subscription Panel
This integration is packaged with an optional Subscription panel which requires that you configure it to allow Users to

subscribe to specific criteria on injected Events. Configuring the Subscription panel requires the following steps:

l Define the Event Domain predicates

l Define a Subscription Domain

l Create a Subscription

l Create a fail-safe Group

Before you can configure the custom Subscription Panel, the NNMiSubscriptionForm.jsp file must be installed as described in

“Installing the Subscription File” on page 6.

Note: The Subscription Panel file, NNMiSubscriptionForm.jsp, must be copied to the correct directory during the

integration installation, as described in "Installing the subscription files" on page 8.
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Defining Event Domain predicates
For the default Subscription panel provided with the integration, the following Event Domain predicates must be defined

(case sensitive):

l SEVERITY

l CATEGORY

l NAME

l SOURCENODENAME

l SOURCEOBJECTNAME

l PRIORITY

l FAMILY

l NATURE

You can also use the following steps to add other predicates that you consider important and which you plan to add to the

integration as explained in "Adding new parameters" on page 41.

To define the Event Domain predicates:

1. In xMatters, click the Developer tab.

2. On the Event Domains page, click hpnnmi.

3. On the Event Domain Details page, click Add New.

4. Add the following predicates to the Event Domain:

Predicate Type Important Values Description

SEVERITY List Manually

entered

Severity is a list predicate containing some or all of the

following values (case sensitive):

l Critical

l Major

l Minor

l Normal

l Warning.

The items listed for Severity should be specifically

chosen to match the severity of the events forwarded

from HP NNMi. Exclude any severities that will not be

submitted for notification.

This predicate corresponds to the $severity variable in

HP NNMi.

Event Domain predicates
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Predicate Type Important Values Description

CATEGORY List Manually

entered

Category describes the type of incident; allowed values

are:

l com.hp.nms.incident.category.Accounting

l com.hp.nms.incident.category.Alert

l com.hp.nms.incident.category.Config

l com.hp.nms.incident.category.Fault

l com.hp.nms.incident.category.Performance

l com.hp.nms.incident.category.Security

l com.hp.nms.incident.category.Status

HP NNMi will generate only the values listed above.

Exclude from your list any categories that will not be

submitted for notification.

This predicate corresponds to the $category variable in

HP NNMi.

NAME List Yes Manually

entered

Name is the incident type of the event. You can have

any number of incident names listed here, but they

should be only those types you have configured to

inject messages into xMatters.

Some example incident types are:

l AddressNotResponding

l InterfaceDisabled

l InterfaceDown

l NodeDown

l NonSNMPNodeUnresponsive

l WANEdgeRouterUnresponsive

This predicate corresponds to the $name variable in HP

NNMi.

SOURCENODENAME List Yes Automatically

generated

Source Node Name is the name of the Node that is the

source of the incident. Leave the values of this list blank

as it will be populated through a web services call to HP

NNMi.

This predicate corresponds to the $sourceNodeName

variable in HP NNMi.

This predicate may be populated with pre-defined values

as well, for more information see "Configuration

Variable Reference" on page 47.

SOURCEOBJECTNAME Text Manually

entered

Source Object Name is the name of the Object that

generated the incident. The Object can be determined

through a combination of the Object Name and Family.

As this is a text field, you can use any number of filters

on the results.
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Predicate Type Important Values Description

PRIORITY List Yes Manually

entered

Priority is how important fixing the incident is to Users.

This is in contrast to Severity, the level of which is

automatically determined by HP NNMi. Note that

xMatters allows the priority to be altered by notificaiton

recipients.

Valid values for Priority are:

l com.hp.nms.incident.priority.High

l com.hp.nms.incident.priority.Low

l com.hp.nms.incident.priority.Medium

l com.hp.nms.incident.priority.None

l com.hp.nms.incident.priority.Top

This predicate corresponds to the $priority variable in

HP NNMi.

FAMILY List Manually

entered

Family is the type of object that generated the incident.

Valid values for Family are:

l com.hp.nms.incident.family.Address

l com.hp.nms.incident.family.AggregatePort

l com.hp.nms.incident.family.Board

l com.hp.nms.incident.family.Connection

l com.hp.nms.incident.family.Correlation

l com.hp.nms.incident.family.HSRP

l com.hp.nms.incident.family.Interface

l com.hp.nms.incident.family.Node

l com.hp.nms.incident.family.OSPF

This predicate corresponds to the $family variable in HP

NNMi.

NATURE List Manually

entered

Nature is a list predicate that describes how HP NNMi

views the incident.

Valid values for Nature are:

l ROOTCAUSE

l SECONDARYROOTCAUSE

l SYMPTOM

l USERROOTCAUSE

This predicate corresponds to the $nature variable in HP

NNMi.

Defining a Subscription Domain
The Subscription Domain is the reference point of the optional Subscription panel and allows you to control who can create

Subscriptions, how recipients can respond to Subscription notifications, and which Event Domain predicates can be used to

create a Subscription. You must create a Subscription Domain before you can create Subscriptions with the new panel.
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To create a Subscription Domain:

1. On the Developer tab, in the Developer menu, click Add Subscription Domain.

2. In the Event Domain drop-down list, select hpnnmi, and then click Continue.

3. On the Subscription Domain Details page, in the Name field, type hpnnmi.

l By default, Subscriptions are non-FYI (i.e., they support response options). To disable two-way Subscription

notifications, select the One-Way check box.

4. In the Custom Page URL field, enter the following path:

jsp\subscription\NNMiSubscriptionForm.jsp

5. Click Continue.

6. On the Select Appropriate Response Choices page, specify the available responses for this Subscription, and then click

Continue.

l By default, the scripts support the following response choices: “Acknowledge”, “Set Priority <level>” (where

<level> equals “Top”, “High”, “Medium”, or “Low”), “Close”, “Ignore”, and “Annotate”. To enable two-way

communications for Subscriptions, define all response choices on the Select Appropriate Response Choices page.

If you require only one-way, informational notifications, do not specify any response choices.

Note: By default, Subscriptions are FYI (informational-only notifications). To enable two-way subscription notifications,

set the forcefyi Event Domain Constant to "disable". For more information, see "Defining Event Domain

Constants" on page 11.

7. On the Select Appropriate Predicates page, add all of the predicates to the Applied Predicates list, and then click

Continue.

8. On the Select Roles page, specify the Roles you want to be able to create Subscriptions on the Domain, and then click

Save.

Note: For more information about working with Event and Subscription Domains, see the xMatters (alarmpoint) engine

installation and administration guide.

2.3.1 Configuring the Subscription JSP
You can use one of the following methods to populate the predicate list values on the Subscription Panel:

n Manually specify the predicate list values in the web user interface (also referred to as "demonstration mode").

n Using web services, query HP NNMi for possible values, and automatically populate the predicate lists with the results

of the web service call.

Note: Changing Subscriptions by adding or removing Event Domain predicates may cause existing Subscriptions to fail.

For more information about working with Event and Subscription Domains, see the xMatters (alarmpoint) engine

installation and administration guide.

Specifying predicate lists manually
To configure the Subscription panel in a demonstration mode, using predefined predicate list values, you must modify the

Subscription JSP.

To manually populate the predicate lists:

1. Open the <xMHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription\NNMiSubscriptionForm.jsp

file on the xMatters web server.

2. Set the Boolean variable QUERY_SOURCENODE_PREDICATE_VALUES to false.

3. Save and close the NNMiSubscriptionForm.jsp file.
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4. In xMatters, click the Developer tab.

5. On the Event Domains page, click hpnnmi.

6. On the Event Domain Details page, click SOURCENODENAME in the Predicates list.

7. Add to the predicate list values, and then click Save.

The SOURCENODENAME list on the Subscription will now be populated with the predefined list values instead of the web

service call results.

Populating predicate lists automatically
If you want to populate the predicate values lists from HP NNMi through web service calls rather than the predefined

predicate list values, you must configure the connection properties within the JSP file.

To configure the Subscription JSP to connect through web services:

1. Open the <xMHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription\NNMiSubscriptionForm.jsp

file on the xMatters web server install.

2. Within the Subscription JSP, locate the following section:

final String NNM_NODE_SERVICE_WS_URL = "http://localhost:80/NodeBeanService";

final String NNM_WS_USER = "webservices";

final String NNM_WS_PASSWORD = "nnm";

3. Replace the value within quotes for each parameter as described in the following table:

Parameter Value

NNM_NODE_SERVICE_WS_URL The URL for the HP NNMi web services NodeBean.

NNM_WS_USER User name of the HP NNMi web services client.

NNM_WS_PASSWORD Password for the HP NNMi web services client.

Subscription JSP parameters

4. Save and close the JSP.

Note: The NNM_WS_USER and NNM_WS_PASSWORD must match the User configured in "Installing the integration

service" on page 6.

Creating a Subscription
You can now use the custom Subscription Panel to subscribe to HP NNMi events that match specific criteria. For example,

you could configure a subscription that would send an informational notification to a specific User each time an event

entered the system that was of critical severity. These notifications, and their responses, do not affect the normal progression

of an event through the system.

To create a Subscription:

1. On the Alerts tab, in the Alerts menu, click My Subscribed Alerts.

2. Select the hpnnmi Subscription Domain, and click the Add New link.

3. On the Subscription Details page, specify a name for the Subscription, and set the Subscription criteria using the tabs.

4. When you are satisfied with the criteria, click Save to create the Subscription.

n The Details tab (Ctrl-click to select more than one value):
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n The Preferences tab (defines the Timeframe and Overrides applied to events for Subscription notifications):



xMatters (alarmpoint) for HP Network Node Manager i

Chapter 2: Installation and Configuration | 29

n You can review the Subscription details at any time on the Summary tab:

Creating a fail-safe Group
If an event is submitted to xMatters when the fail-safe functionality is enabled, and there is no subscription that matches the

event, xMatterssends the notification to the fail-safe recipient. The fail-safe recipient is typically a Group, but can be

configured as a User.
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To create a fail-safe Group:

1. In xMatters, click the Groups tab.

2. Create a new Group named HP NNMi Fail Safe, with at least one User as a Team member to receive notifications.

For more information about creating Groups and Teams, see the xMatters (alarmpoint) engine user guide.

Note: If you want to use an existing Group or a different Group name, modify the value for the failsafegroup Event

Domain Constant. You can also eliminate notifying any fail-safe group by setting the failsafe constant to disabled.

For more information, see "Defining Event Domain Constants" on page 11.

2.4 Configuring HP NNMi
Configuring HP NNMi to combine with xMatters requires the creation of a web services client.

2.4.1 Creating a web services client
Configuring a web services client allows notification responses to update the HP NNMi incidents appropriately.

To create a web services client:

1. Launch the HP NNMi Web Console, and log in as an Administrator.

2. Under the Configuration Workspace, click User Accounts.

3. On the User Accounts tab, click New.

4. On the Account Mapping page, in the Account drop-down list, select New:

5. On the User Account page, specify the Name and Password for the Web Services Client User:

Note: By default, the user name and password configured within the xMattersAction Scripts are "webservices" and "nnm",

respectively. If you want to use a different name or password, you must update the configuration variables in the

initial PROCESS Action Script. For more information, see "Configuring the web services connection" on page 21.

6. Click Save and Close.

l The “webservices” user is now specified in the Account field on the Role page.

7. In the Role drop-down list, select Web Service Client.
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8. Click Save and Close.

l The Web Service Client will now allow xMatters responses to update NNMi incidents using Web Service Calls.

The webservices user is listed on the User Accounts and Roles page:

9. Under the Configuration Workspace, click User Account Mappings.

10. Click New, and then associate the web services client account with the NNMi Web Service Clients group.

11. Click Save and Close.

2.4.2 Identifying your HP NNMi port
You can determine whether the default port setting of 80 is correct for your HP NNMi installation by checking the port

information contained in the HP NNMi port configuration file, located in the following folder:

<NNM_DATA_DIR>\conf\nnm\props\nms-local.properties

Note: The default <NNM_DATA_DIR> folder (for Windows installations) is C:\Documents and Settings\All

Users\Application Data\HP\HP BTO Software.
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Chapter 3: Integration Validation
After configuring xMatters and HP NNMi, you can validate that communication is properly configured. It is

recommended that you start the components in the following order:

l HP Network Node Manager i

l xMatters (alarmpoint) engine

l xMatters integration agent

Consult the respective user manuals for details on starting these applications.

The following sections will test the combination of xMatters and HP NNMi for notification delivery and response,

Subscription Panel functionality, and synchronization configuration. This section also includes an explanation and

demonstration of how to query HP NNMi via the mobile access component using a BlackBerry.

3.1 Enabling WS-Eventing Subscription Manager Logging
This section describes how to verify that the xMatters integration agent service can communicate with HP NNMi.

If the connection cannot be established, verify that the connection parameters in

<IAHOME>\integrationservices\ hpnnmi\nnmi-config.js are correct and restart the integration agent.

To enable logging:

1. Open the <IAHOME>\conf\log4j.xml log configuration file.

2. Uncomment (enable) the section "All Integration Services"; it should now resemble the following:

<!-- All Integration Services -->

<logger name="com.alarmpoint.integrationagent.services">

<level value="DEBUG"/>

</logger>

This turns on DEBUG logging for all integration services.

3.1.1 Verifying the connection
Once you have enabled the debug logging, you can check the log files to verify that the connection has been

properly established.

To verify the xMatters – HP NNMi connection:

1. Open the integration agent log file at <IAHOME>\log\AlarmPoint.txt.

2. Locate the following sections:

l If the Integration Service javascript has successfully started and connected to HP NNMi, the log file should

contain a result that resembles the following:

2011-03-04 15:19:43,551 [Thread-8] DEBUG - Agent Client: [hpnnmi.js] Subscription with

NNMi (http://192.168.170.168:8004

/nms-sdk-notify) has been made with message id (8bbd4e28-f8d0-46b3-896a-bf8d06e6d3a0).

Subscription ID: urn:jbwse:266b08

71-d966-4d0f-aa18-7b9217aa6da2 Expiry: Fri Mar 04 15:21:43 PST 2011 Renew in: 89449(ms)

l If the Subscription Manager has failed to connect to HP NNMi, the log file should contain an error message

that resembles the following:

2011-03-04 17:21:46,557 [Thread-12] ERROR - Agent Client: Cannot make web service call.

Please check configuration information in nnmi-config.js
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3.2 Triggering a notification
The following example shows resolution of a network outage on a monitored LAN.

3.2.1 Increase the Polling Frequency
The following section describes how the fault polling interval can be decreased to speed up the demonstration.

To adjust the fault polling interval:

If it is not already running, launch HP Network Node Manager i.

1. Log in to the HP NNMi Web Console as an Administrator.

2. Select the Configuration Workspace.

3. Open Monitoring Configuration.

4. On the Default Settings tab, in the Default Fault Monitoring dialog box, set the Fault Polling Interval to 15 seconds:

l A Fault Polling Interval of 15 seconds may be too short an interval on larger deployments, and can consume

significant resources on the HP NNMi system. You may need to increase the interval when moving to a

production deployment.

5. Click Save and Close.

3.2.2 Disconnect a Computer from the LAN
If HP NNMi is monitoring a LAN, one of the easiest ways to trigger a notification is to interrupt the communication between

HP NNMi and one of the computers on the LAN. The following steps describe how to do this and what to expect.

1. Physically disconnect a computer from the local area network (using a computer other than the xMatters or HP NNMi

servers).

2. When the computer goes offline, an incident will be triggered within HP NNMi and can be viewed in the Incidents

workspace under Root Cause Incidents (or another category depending on the trigger).

l The Notes entry for the open incident indicates that this event has successfully notified an xMatters User:
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3. To display the full Notes for an incident, click the Open Incident button to open the incident, and view the Notes area:

4. The target’s specified contact type will receive a message corresponding to the notification, as shown in the following

section.

3.3 Responding to a notification
This section describes how to respond to a notification from xMatters. In the following example, the notification is received

on a BlackBerry Device, but the process is similar for all Devices.

To respond to a notification:

1. When a notification arrives for the User, the Device indicates the number of calls received:

2. Opening the notification displays its details:
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3. Scrolling down will display the remainder of the details, and the list of possible replies:

4. To respond to the notification, the User clicks a response choice, and xMatters updates the event in HP NNMi.
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For more information about response choices, and changing the options available to Users, see "Response choices" on page

42.

3.4 Viewing response results
In the Root Cause Incidents table, the In Progress arrow indicates that the incident has been acknowledged, and a message

will be logged within the Notes field indicating who took responsibility.

To view the notification results:

1. Open the HP NNMi Web Console.

2. In the Incident Workspace, under Root Cause Incidents, locate the incident used for testing notifications.

l The Life Cycle State has changed to In Progress, indicating that the incident was acknowledged from xMatters:

3. To display the acknowledged incident’s details, click the Open button.

l The Notes field indicates that the incident was acknowledged by bsmith:
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3.5 Testing the Subscription Panel
To test Subscriptions, ensure that you have created a Subscription (for more information, see "Creating a Subscription" on

page 27), and then trigger a notification that matches the criteria in our Subscription. You will receive an FYI Notification

(informational only) which will not have any response choices available.

3.6 Querying for an event
This section describes how to validate that the mobile access component, integration agent and HP NNMi are properly

configured.

Note: The xMatters mobile access page has a default URL of http://<xMattersIP>:8888/mg, where <xMattersIP> is

the IP address of the xMatters web server where the mobile access component is configured.

To query for an incident:

1. Using a browser-enabled smart phone (such as a BlackBerry), open a browser and navigate to the mobile access

component IP address:
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2. Log in to view the list of available integration services.

l If more than one integration service is available, select the hpnnmi service.

3. If prompted, enter the HP NNMi login credentials, and then click the Query Incidents menu item:

4. Enter your search criteria in the fields provided:

5. Click Submit to list all matching incidents:
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6. Click the link for an incident to view its details:

7. To view the available options for the incident, click the drop-down list at the top of the screen:

8. To update the issue, select Basics from the drop-down list:
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9. On the Basics screen for the incident, click the Lifecycle State drop-down list, and then select a new status:

10. Log in to HP NNMi and view the details for the incident to confirm that it has been updated.
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Chapter 4: Optimizing and Extending the Integration
This section describes some of the available methods you can use to optimize or extend the xMatters (alarmpoint)

for HP Network Node Manager i integration.

4.1 Adding new parameters
Additional data elements (or tokens) can be forwarded to xMatters by adding them in HP NNMi. The following

steps explain how to add a new event token to the event injected to xMatters.

Note: For more information about which parameters may be available, refer to the HP NNMi documentation.

To add an event parameter:

1. Open the <IAHOME>\integrationservices\hpnnmi\hpnnmi.js file.

2. To add a new child node to the generated APXML data, locate the function apia_http

 (httpRequestProperties).

3. Locate the following comments:

// add custom tokens

// data.appendChild(<custom_parameter>{content.incidentResent.text()}</custom_parameter>);

// data.appendChild(<custom2>static custom token value</custom2>);

4. Add an appendChild command.

data.appendChild(<custom_parameter>{content.incident_parameter.text()}</custom_

parameter>);

The new parameter can now be used within the xMatters Action Scripts. The following section illustrates a possible

use for the variable.

4.1.1 Adding new parameters to notification content
Once you have injected the new data elements, you can add the token as a parameter to the notification content for

Devices. The following steps explain how to add the custom parameter to email notifications; adding content for

other Device types is similar and requires the presentation script to be modified for the specific Devices.

To add a new token to email notification content:

1. Open the xMatters Developer IDE and check out the HP Network Node Manager (BUSINESS) Script Package.

2. In the Presentation Action Script, add the following line to the email content creation section:

$content.message = $content.message & "TokenName: " & $event.tokenvalue & "\n"

3. You can also add a check in the Initial script to confirm that the custom parameter was injected properly and

exists within the Action Scripts:

IF ( ! EXISTS( $event.custom_parameter ) )

$event.custom_parameter = $undefined_default

IF ( $main.debug )

@script::log( $main.log_prepend & "Optional token ' custom_parameter '

not found, defaulting to '" & $event.custom_parameter & "'" )

ENDIF

ENDIF

Your custom parameter should now appear in the notification content for email Devices.
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4.2 Response choices
This integration allows recipients to respond to notifications with several default choices, some of which are injected back to

the HP NNMi server, updating the original incident. Users notified on email Devices also have the ability to respond with an

extra annotation message which will be logged in the original incident, as described in "Adding annotation messages",

below.

The following is a list of the default response choices available with the integration and their associated actions on the

xMatters event and the HP NNMi incident.

Response Description

Acknowledge User takes ownership of the incident, preventing further notifications to other Users. (The

exception is subscription FYI notifications, which are reporting on the service outage. These

are not stopped until the problem has actually been solved.)

Ignore Stops notifying the current User.

Raise Priority Increases the priority of the incident in NNMi by one level. (Voice only)

Lower Priority Decreases the priority of the incident in NNMi by one level. (Voice only)

Set Priority Top Sets the priority of the incident to Top. (Email, BES, and browser only)

Set Priority High Sets the priority of the incident to High. (Email, BES, and browser only)

Set Priority Medium Sets the priority of the incident to Medium. (Email, BES, and browser only)

Set Priority Low Sets the priority of the incident to Low. (Email, BES, and browser only)

Annotate Allows the User to append a message to the Notes field of the NNMi incident. (Non-

HTML Email only)

4.2.1 Adding annotation messages
Two-way email Device notifications (not FYI) can add extra annotations that will be added to the HP NNMi incident as a

message on the Journal Updates tab. To add an extra annotation, respond to an email notification with the following format

in the subject line:

RESPONSE <Choice> <Message>

<Choice> can be any of the response choices listed in the table above, and <Message> can be any content you want to add

as the annotation.

4.2.2 Changing and adding response choices
The response choices and behavior can be changed in the response script in the Action Script set (to change Subscription

responses, update the subscriptionResponse script). Actions available through web service calls include acknowledging an

incident, annotating it, and changing its priority. Any other response functionality for the integration must be configured

within the response HANDLER script with HP NNMi provided web service calls.

As an example, the following code illustrates adding a response choice of "Be there in 10 minutes" to the integration:

Presentation Script

$content.choices::add( "be there in ten minutes" ))
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Response Script

# Handle responses

$reply = $response.reply

$reply::toLowerCase()

$ten_minutes= $reply::startsWith( "be there in ten minutes" )

...

IF ( $ten_minutes )

# Perform any changes to the AlarmPoint event and notifications here

@event::delinkAll() # Consider the incident handled

$main.continue = true

…

# Acknowledge Event on Management System

GOSUB acknowledgeIncident

...

# Acknowledges the original NNM incident using a web service call, changing the lifecycle state

acknowledgeIncident:

@nnmiRequest = new NetworkNodeManagerScriptObject( $main.nnmi_incident_url,

$main.nnmi_username, $main.nnmi_password )

IF (! EXISTS($event.nnm_id))

$event.nnm_id = @nnmiRequest::getNNMIncidentId($event.incident_id)

ENDIF

$request_successful = @nnmiRequest::acknowledgeIncident($event.nnm_id)

IF ($request_successful != true )

$err_msg = "Failed to acknowledge NNMi incident: " & $event.incident_id

IF ( $main.debug )

@script::log( $main.log_prepend & $err_msg )

ENDIF

@event::report( $err_msg )

ENDIF

RETURN

The above is intended only as a brief overview of the required components. For more information about responses and

scripting, refer to the xMatters Action Scripts and the xMatters Online Developer's Guide.

4.3.1 Responses for FYI notifications
FYI notifications do not have any response choices available, except for FYI notifications sent to voice Devices. Voice FYI

notifications offer the following response choices so that Users can navigate between multiple notifications. (This navigation

is not required on other Devices.)

Response Description

Delete Removes the notification from the User’s list. This option is most likely to be selected.

Save Saves the notification and stops attempting to deliver it to the User’s other Devices. Users may select this

option to delay listening to the notification when it is delivered, and access the details by calling in, or via the

xMatters web user interface, at a later time.

Repeat Replays the notification content.

Voice Device responses for FYI notifications

4.4 Annotations
This integration extensively annotates the originating HP NNMi incident, but this may not be desirable in all environments.

To prevent the annotation of an incident, change the "annotate" Event Domain Constant to false. For more information, see

"Defining Event Domain Constants" on page 11.



xMatters (alarmpoint) for HP Network Node Manager i

Chapter 4: Optimizing and Extending the Integration | 44

4.5 Altering the duration of events
You can modify the amount of time xMatters will send out notifications for a particular event before it times out by changing

the "timeout" Event Domain Constant. This constant stores the number of seconds the notifications will be allowed to

continue before timing out.

For example, if you wanted to change the event duration to two hours, you could change the value for the timeout constant

to 7200.

Note: For more information about working with Event Domain Constants, see "Defining Event Domain Constants" on

page 11.

4.6 FYI Notifications
You can make all notifications informational only (i.e., the user is not offered any response choices) by setting the "forcefyi"

 Event Domain Constant to "on". This makes all normal and Subscription notifications one-way (FYI). For more information,

see "Defining Event Domain Constants" on page 11.

Note: All FYI events are set to priority LOW; this allows users to prevent the alerts from being sent to specific Devices by

configuring their Devices to be used for only Medium and High priority alerts.

4.6.1 Generating FYI notifications for Subscriptions
When using subscriptions to inform Users about service outages, you may want to remove responses from notifications

generated for subscriptions.

To accomplish this, select the One Way check box on the Subscription Domain details page for the associated Subscription

Domain.

4.7 Optimizing the mobile access component
This section describes some of the ways you can optimize or extend the xMatters mobile access portion of the xMatters

(alarmpoint) for HP Network Node Manager i integration.

4.7.1 Add a Custom Query to the Home Page
To add a custom query and link to the home page, add the following to the <xMHOME>\webservices\webapps\

mobilegateway\jsp\hpnnmi\configuration.jsp file installed on the mobile access component:

MAIN_MENU_OPTIONS.put("Query Label", "Query");

For more information about constructing queries for HP NNMi, consult the HP NNMi documentation.

4.7.2 Creating a URL Alias
The urlAlias.jsp page in the mobile access component is used to drive directly from an xMatters notification to the Create

Incident or Update Incident screens. It supports the following parameters:

Name Description

newIncident If this parameter is set, a new incident will be created and you will be taken to the Create Incident screen. If

it is not set, you will be taken to the Update Incident screen for the specified incident.

urlAlias.jsp parameters
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Name Description

IncidentID The incident number of the incident to update. If the newIncident parameter is not set, this field must be set

to a valid incident number.

Field Name The name of an API Caption of a field for the incident. For each parameter set, it will update the field on the

incident with that value.

For more information about the urlAlias method in the xMatters Action Script, refer to the xMatters Online Developer's

Guide.

4.8 Constructing BES and email notifications
You can configure xMatters to create BES and HTML email notifications.

This feature requires the xMatters Developer IDE. For installation instructions, refer to the xMatters Online Developer's

Guide.

To enable BES and HTML email, the HP Network Node Manager (Business) script package set must be checked into the

Developer IDE Database. If the script package has not been checked in already, see the instructions in "Importing the script

package" on page 9.

Note: Some email clients, such as Microsoft Outlook 2007, may not display HTML elements correctly. It is recommended

that you test the HTML compatibility of your email client before implementing the HTML email feature.

To enable BES and/or HTML email:

1. In xMatters, click the Developer tab, and then, in the menu on the left side of the screen, click Event Domain

Constants.

2. In the Event Domain drop-down list, select .hpnnmi.

3. On the Event Domain Constants page, do the following:

l Set the enablehtmlemail constant to true.

l Set the uselogo constant to true (if you want your HTML email to show a logo).

l Set the alarmpointurl constant to the base URL of your xMatters web server. (default is localhost).

l If you are using BES, set the bespushurl constant to the URL of the BES server.

Note: If the Event Domain Constants are not present, you can add them using the names specified above. For more

information, see "Defining Event Domain Constants" on page 11.

4. Optionally, you can also use the Developer IDE to make any of the following changes to the Global Configuration

Variables section of the initial PROCESS script in the HP Network Node Manager (Business) Production script

package::

l Change $main.HTML_form_url to point to a JSP page that you want to process any responses from the HTML

email. (the default setting should work out-of-the-box).

l Change $main.logo to a URL that holds the image you want to display at the top of HTML emails (by default,

it points to the xMatters logo).

l Set $main.logo_alt_text to the text you wish to display when the logo cannot be fetched. This can be

displayed if the email client is configured not to show images, or it could be displayed because the email client

cannot access the xMatters web server directly and thus cannot respond by using the links in the HTML.

l If you are using BES and have access to a BES server, you can set the URL to the BES server in the $main.bes_

pushurl variable.

5. Save and validate the script, and check in the script package.
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For more information about these and other configuration variables, see “Configuration Variable Reference” on page 55.

4.9 Troubleshooting
This section identifies and explains some issues with the integration that may be encountered during installation,

configuration, or validation.

4.9.1 Voice files
Note that on multiple-Company deployments, the voice files must be installed to <xMHOME>\node\phone-

engine\Datastore\<company_id>\common\recordings\english\phrases, where <company_id> is the database

identifier of the Company where the servicenowim Event Domain has been created.

If the voice files have already been copied to the above location, but are still not playing in notifications, you can copy the

voice files to the global location at <xMHOME>\node\phone-engine\Datastore\global\common\

recordings\english\phrases. Note that this is the location for the out-of-box voice files; adding the integration specific

files to this location may cause them to be played for notifications not related to HP NNMi.

4.9.2 Known Issues
xMatters plans to address these issues in subsequent releases:

l Acknowledging an incident from within HP Network Node Manager i does not prevent further notification deliveries

by xMatters.

l If the xMatters web server is installed on a different machine than the HP NNMi server, both machines’ clocks must be

set to within 30 seconds of each other; otherwise, the WS-Eventing subscription manager may not work correctly.

Using a common Network Time Protocol (NTP) Server on the xMatters and HP NNMi systems is recommended.

l At time of release the "Acknowledge" response will not assign the responding User as the Owner of the event. This

means that notifications may continue to other Users and the incident may not be updated as "In Progress" in HP

NNMi. This is due to an issue with a web services call in HP NNMi, and will be addressed via an HP NNMi hotfix;

for more information, consult the xMatters community site at http://community.xMatters.com.

l The following error may appear tin the xMatters log, due to the limitations of the Notes field in HP NNMi; this is

scheduled to be addressed in a hotfix available from HP:

REPORT: Recipient: Bob Smith - Home Email - Message: Failed to change priority NNMi incident:

1e47d39a-ca69-4c69-9e40-2009f1db16e3. Exception received from NNMI: JavaException:

com.alarmpoint.integrationagent.soap.exception.SOAPRequestException:

com.alarmpoint.integrationagent.soap.exception.SOAPRequestException:

javax.transaction.RollbackException:

[com.arjuna.ats.internal.jta.transaction.arjunacore.commitwhenaborted]

[com.arjuna.ats.internal.jta.transaction.arjunacore.commitwhenaborted] Can't commit because the

transaction is in aborted state

For more information about the available hotfixes for HP NNMi, contact your HP NNMi representative.

4.10 Uninstalling
For instructions on removing an xMatters deployment, refer to the xMatters (alarmpoint) engine installation and

administration guide.
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Chapter 5: Configuration Variable Reference
This section outlines and describes the configuration variables available in the initial PROCESS Action Script.

Note that many of the configuration variables are configurable using the Event Domain Constants, as described in

"Defining Event Domain Constants" on page 11; those variables are not listed here.

5.1 Global configuration variables
These variables are available throughout the script package, and are parameters of the “main” object. The value

assigned to each variable is its default value within the script.

Variable Description

$main.use_logFile = false Specify whether to use an alternate log file for debugging

messages. This variable is ignored unless $main.debug is

also set to true.

$main.logFile = "../logs/" Defines the file used to log debugging information (only

if $main.use_logfile is set to true).

$main.HTML_form_url = $AlarmPoint_URL &

"/jsp/ProcessNotificationResponse.jsp"

Specifies the URL of the xMatters web server’s Process

Notification Response JSP form, used by HTML email and

BES to inject responses through the system.

$main.logo = $AlarmPoint_URL &

"/static/images/logos/alarmpoint/UNKNOWN.png"

Specifies the path to the graphic displayed on HTML

(email and BES) notifications.

$main.logo_alt_text = “[If the logo does not appear

you may be blocking images or you may be outside

a firewall. If the latter, the links will not work for

responding and you should respond by replying to

this email as described below.]”

The alternate text to display if the HTML email logo is

unavailable.

Note: If the logo does not display, it is unlikely that the

HTML_form_url is valid and responses will not be

injected from HTML Devices (email and BES).

$main.numeric_pager_number = “555-1212” The phone number to display for calling in to retrieve

event information. This variable has a non-existent

number as a default value; a real call-in number must be

supplied, or a message indicating that an xMatters event

has occurred.

Gobal variables

5.2 Local Configuration Variable
These variables are available only in this script, and control how the script runs. For more information about the

initial PROCESS script, consult the xMatters Online Developer's Guide.

5.2.1 FYI and Subscription Notification Variables
The following variables configure the behavior of informational-only, or FYI, notifications. The value assigned to

each variable is the default value within the script.
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Note: For more information on the behavior associated with informational-only notifications, see "FYI Notifications" on

page 44.

Variable Description

$use_email_for_fyi = true

$use_phone_for_fyi = false

$use_im_for_fyi = true

$use_text_phone_for_fyi = true

$use_text_pager_for_fyi = true

$use_numeric_pager_for_fyi = true

$use_bes_for_fyi = true

$use_generic_for_fyi = true

Configure Device filters for informational-only (FYI) notifications.

Setting these flags to false prevents that Device type from being notified with

informational (FYI) messages.

FYI and Subscription variables

5.3 xMatters mobile access configuration variables
The <xMHOME>\webserver\webapps\mobilegateway\jsp\hpnnmi\configuration.jsp file installed for the mobile

access component contains the following configuration variables:

Variable Type Description Default Value

MAIN_MENU_COUNTS Boolean Enables the queries on the home page to be run true

MAIN_MENU_OPTIONS map Defines what queries should be displayed on the

homepage

High Priority

Incidents

Open Incidents

Assigned To Me

Hot Incidents

Unassigned

Incidents

PAGINATE_RESULTS boolean Enables pagination the incidents lists true

RESULTS_PER_PAGE int Defines how many results should be displayed on each

page of the incidents lists

10

USER_NAME_FIELD string Defines the name of the custom field in xMatters

containing the HP NNMi login user name

"HP NNMi

Login"

PASSWORD_FIELD string Defines the name of the custom field in xMatters

containing the HP NNMi login user password

"HP NNMi

Password"

VERIFY_CREDS boolean Enables the validation of entered HP NNMi login

credentials when loading the mobile access component

homepage

true

LISTS_EXPIRED long Defines how long to cache list values retrieved from

HP NNMi through web service calls

3600000

xMatters mobile access variables
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